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Thank you for purchasing the ARTURIA’s ANALOG FACTORY!

In this package you will find:

» a CD-ROM containing the ANALOG FACTORY installer for MAC OSX and Windows
XP/2000

» a USB (Syncrosoft) protection key you will need to run ANALOG FACTORY
» the Authorization Card

» the User’s Manual

Carefully store your USB key and your card. The USB key will be required any time
you run ANALOG FACTORY, so your key is the real value of your product. See chapter
two for more information about how the key works.

We recommend that you register your product. By registering, you identify yourself
as the legitimate owner and will be sure to receive the latest news and updates for
your product. After registration, you will receive a user ID and password in order to
access a protected area on our site. It also puts you on our user notification list, so
that you can be the first to know when there are updates or new product offers.
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1 Introduction

1.1 History

In early 2001, Arturia began working on an advanced algorithm for the digital
emulation of analog circuits’ audio characteristics. In non-technical language, this is
an unprecedented way of creating the very unique sound one finds in a synthesizer
such as the Moog Modular. Nearly a year after they began work on the algorithms,
Arturia was ready for feedback. At the 2002 NAMM show in California, Arturia shared
an early version of what would later be the Moog Modular V with the renowned maker
of the original Moog synthesizer, Doctor Bob Moog.

In seeking insight from sound production experts, such as Dr. Moog, as well as avid
synthesizer users, Arturia was able to ensure the quality of the instruments they
made; so well in fact the Dr. Moog himself endorsed the Moog Modular V. The launch
of this sound powerhouse was an instant success, winning awards from several top
magazines, and leading to the development of other synth recreations.

Shortly thereafter, Arturia started receiving many requests from musicians, producers
and bands. Many of them explained how they were planning to replace their original
hardware synthesizers by virtual instruments. Artists around the globe were
beginning to see the advantages of a software alternative to hardware-based
synthesizers.

The CS-80V emulated the legendary Yamaha CS-80, considered by many as "the
ultimate polyphonic" synthesizer, was launched at the AES 2003 in New York.
Imagine some of your favorite music from diverse artists such as Keith Emerson or
Stevie Wonder, and you will have a mental glimpse of the sonic capabilities of the CS-
80V.

Released at the NAMM 2004, the minimoog V is a recreation of the Minimoog, quite
possibly the most famous synthesizer ever. The original minimoog has been big on
the music scene since the 70’s; still today the Minimoog has a large following for its
many sound capabilities.

The ARP 2600 V was launched at the NAMM 2005 in Anaheim. This is a faithful
reproduction of the ARP 2600 and is great for just about any sound one might wish to
create: everything from drum n’ bass stabs to Star Wars’ R2-D2 have been made with
the Arp.

At the Winter NAMM Show 2006, ARTURIA announced the release of its seventh
product: the Prophet V. This powerful hybrid gives you two instruments in one: it
combines the warmth of the legendary Prophet 5 programmable analog synth with
the unique Vector Synthesis textures of the digital Prophet VS.

1.2 1.2 Here and Now

Analogue Factory brings you the best spectrum of sounds from all of the above
instruments in an easy to use, no-hassle interface. As you will soon see in exploring
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the instrument yourself, a single instrument gives you your pick from the most
complete synthesis sound palette one could ask for: the great Bass’ of the Moog
Modular, the Brass and Strings of the Prophet, the Pads and FX of the Arp 2600, etc...

If you have never played a real synth, or even if you don't know what a synthesizer
is, it is not important; you will be glad to have invested in such a powerful instrument
once you hear the difference Analog Factory makes in your studio.

1.3 TAE

TAE®, True Analog Emulation, is Arturia's outstanding technology dedicated to the
digital reproduction of analog circuits used in vintage synthesizers.

When implemented in software code, TAE®’s algorithms guarantee authentic
emulation of hardware specifications. This is why the ANALOG FACTORY, and all of
Arturia’s virtual synthesizers, do offer an unparalleled quality of sound.

TAE® combines four major advances in the domain of synthesis:

1.3.1 Aliasing-free oscillators
Standard digital synthesizers produce aliasing in high frequencies, and also when
using Pulse Width Modulation or FM.

TAE® allows the production of totally aliasing-free oscillators in all contexts (PWM,
FM...), and at no extra CPU cost.

42 dB at 9 705 Hz

Aliasing
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Linear frequency spectrum of an existing well-known software synthesizer
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1.3.2 A better reproduction of analog oscillator waveforms

The waveforms produced by the oscillators in analog synthesizers are marked by the
presence of a capacitor in the circuits. The discharge of the capacitor results in a light
bend in the original waveform (notably for saw tooth, triangular and square
waveforms). TAE® allows the reproduction of this capacitor discharge. This is the
analysis of a waveform from one of the 5 original instruments that Arturia’s software
emulates, and that of the ANALOG FACTORY. They are both equally deformed by the
low-pass and high—pass filtering.
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Temporal representation of a “"saw tooth” waveform reproduced by TAE

What's more, the hardware analog oscillators were unstable. In fact, their waveform
varies slightly from one period to another. If we add to this the fact that the starting
point for each period (in Trigger mode) can vary with the temperature and other
environmental conditions, we find one of the characteristics that contributed to the
typical sound of vintage synthesizers.

TAE® reproduces the instability of oscillators, bringing a fatter and “bigger” sound.

1.3.3 Direct Filter Circuit Modeling

Due to advances in computer processing power, the ANALOG FACTORY can now
employ direct filter modeling techniques to achieve unprecedented accuracy in the
emulation of a hardware synthesizer’s filter. By modeling the operation of the
individual hardware components of the filter circuit, the warm nuances synonymous
with analog sounds are recreated. This graph is a frequency domain plot as just a
single example of direct circuit modeling in action; it shows the generation of
harmonics at multiples of the resonant frequency when the filter is in self oscillation
mode, for both one of Arturia’s virtual instruments and what it is emulating. These
harmonics are characteristic of hardware synthesizer’s filters and are due to the non-
linear behavior inherent in its analog circuitry. The harmonics generated add to the
richness and warmth of the sound produced by the filter. As a result of the direct
recreation of this analog circuitry, the same characteristics of the sound are present,
thus giving the user a truly analog sound.
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Comparison of Harmonics generated by the filter circuits of the ANALOG FACTORY and a
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2 Installation

2.1 Notes about E-licencer protection and the installation:

The Analog Factory application is delivered with a USB key/E-Licenser. This key
contains your ANALOG FACTORY license and authorizes the software to function. To
use the software on a different machine, simply install the software on that computer
and then plug in the E-Licenser. In this way, you can use this system key to install
licenses of other Arturia products, or other products that use Syncrosoft technology,
and carry the license from computer to computer as you wish.

In order to function correctly, the E-Licencer driver must be already installed on your
system.

The installation program for the Syncrosoft License Control Center is available on CD-
Rom and will be launched automatically when the installation of the Analog Factory is
complete.

You can also download the latest version at this address:

http://syncrosoft.com/downloads/

Once you have installed the driver, an application called <<License Control Center>>
allows you to manage the installed licenses on your key.

On Windows, this application and its documentation are available via the menu
Start-> Programs -> Syncrosoft.

On Macintosh, this application is installed in the Application folder of your system
and the documentation is available from the Help menu of this particular application.

Important Note:

Your license number, and thus the key on which it is installed, represents the true
value of your software. To lose the E-Licenser is to lose the use of the software on
which the licenses are installed. Take special care of this key.

2.2 Windows Installation

» Insert the CD-ROM into the drive. Explore the contents of the CD-ROM and
double click on the icon called <<Analog Factory Setup.exe >>.

» After having accepted the license agreement, you can choose the folder in which
the Analog Factory will be installed
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Choose install Directory |

Please chooze a directony.

Path:
|E:'xF'F|DGF|.-’-‘-.M FILES Arturiahtnalog Factant,

Directaries:

[~ PROGRAM FILES

= o -] ok, |
_ Cancel |

Cancel

£ ARP2600Y
(] BRASS
£ 0580V =

Cirives;

| = c: 5YSTEM -] Réssau.

Choose the Installation Folder

» Next, select the protocol(s) that you wish to install. The available options are:
e The VST plug-in
e The RTAS plug-in

Prophet ¥ Plug-in Installation

The =oftware will be inztalled on your computer. v'ou may alzo want to
inztall one or more of the following protocols ;

W ST Protocol
™ RT&S Protools protocols

]S

Choose your protocol

For more information on those protocols, please see to chapter 4 of this manual.

» For the installation of the VST and RTAS protocols, you should select the
installation folder of these plug-ins to allow the host application to use them. If you
don’t know how to do this, go to the Protocol Chapter (Ch. 4).
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¥5T Plugins directory |

Diirectories:

[=> Steinberg Cancel
[= Cubaze 5

BE= atpluging

£ Cubase 5 Instruments |

= =\ <] ok,
[=* Pragram Files I—'l

Dirives:

| = c: 5vsTEM -] Réssau.

Select installation folder for plug-ins

» A dialogue box will ask you if you wish to have a shortcut on your desktop. This
will give you access to the standalone application.

Analog Factony

Shortcut to your desktop

» The installation program will then ask to install the Syncrosoft drivers. These
drivers are necessary for the protection key; for the ANALOG FACTORY to function
properly the latest version of Syncrosoft must be installed. If you are sure that your
system possesses the most recent Syncrosoft drivers, you can click on the “Cancel”
button. Otherwise, click "OK".

» Next, the installation program proceeds with installation of the Syncrosoft E-
licenser driver and License Control Center. In order to do this, it will execute the
available Syncrosoft installer of the CD-Rom. Follow the instructions of the installer.

The installation program now has enough information to finish. In a few seconds you
will be able to use Analog Factory.
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2.3 Installation Mac OSX

» Insert the CD-ROM into the drive. Explore the contents of the CD-ROM, and
double click on the icon called <<Analog Factory.pkg>>.

» The installation program, requiring administrative rights, may have the system
ask you to enter the login of an administrative user of the system. In this case, enter
your login and administrative password, and click on OK to continue the installation.

» After the software license has been validated, the installation program will select
the system disc as target by default. It's not possible to install Analog Factory on
another disc. Click on continue to proceed with the installation.

‘e Install Analog Factory

Select a Destination

Select a destination volume to install the Analog Factory
& Introduction ! software.

B License

b

o Select Des‘nm?

® Installatipn Ty@e
9 £

@ Install 7 Macintosh HD
® Finishillp Z330CE (38.2GE Free)

You have chosen to install this software on the volume “"Macintosh
HD."

C Go Back :] (Continue )

P

Choice of installation disc

Analog Factory will automatically install as a standalone application (functioning
independently and apart from any sequencer host). In the same way, all the
available protocols (VST, Audio Unit and RTAS/HTDM) will be installed. For more
information on those protocols, go to chapter 4.

Next, the installation program proceeds with installation of the Syncrosoft key driver
and License Control Center. In order to do this, it will execute the available
Syncrosoft installer of the CD-Rom. Follow the instructions of the installer.

The standalone application will be installed in the applications folder, and the different
plug-ins will be installed in folders reserved to each type of plug-in.
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2.4 Registration

Once your software has been installed, we recommend to you to register online as a
licensed Analog Factory user. This registry isn’t obligatory, but it is highly advised. It
gives you the access to reserved resources for new presets and will make you the first
to know when updates are made available.

There is a product registry card in your software box, which contains your Arturia
license. This license permits you to register and identify yourself as an Arturia
customer. It will be asked for when you are registering.

You will find this registry form at this address:

http://www.arturia.com/en/userzone.php
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3 Using Analog Factory

3.1 Preferences

Preferences are set in Analog Factory by clicking on the ofnalog Factoty logo on
the virtual keyboard. The following options are available:

SHOW ANIMATION: choose to activate or deactivate the animation (keyboard and
Preset Manager folding).

SHOW CONTROL POPUP WHEN: MOUSE CLICKS ON CONTROL: a small popup
window appears each time that the mouse clicks on a modifiable parameter in order
to give information about the parameter and modifiable values. Choose ON to
activate this preference, or OFF to deactivate it. Default is ON.

SHOW CONTROL POPUP WHEN: MOUSE RESTS ON CONTROL: a popup window
will appear when the mouse is left upon a modifiable parameter giving information
about the parameter and the modifiable values. Choose ON to activate this
preference, or OFF to deactivate it. Default is ON.

LCD COLOR: this function offers a choice between several available
colors/combinations on the Preset Manager screen.

3.2 Tool Bar

Standalone N Bl = =l B

File
W MIDIIN M
EGE e [ ]

[4] PRESET NAME INSTRUMENT _ TYPE [SAVE .ﬁi|

IMPORT
[ LtipFsINE £S5 o
| |- -

= EX]

Tool Bar

The tool bar consists of an ensemble of essential icons for the ANALOG FACTORY
organized from left to right allowing the user to see/have access to:

1. Preset, Instrument, and Type Names: Name of the current preset,
name of the Instrument, and the Type of instrument.

2. Save As: saving Presets (sound programming). This function allows the
user to save a preset which has modified, including giving it a new name.
This new preset will be a USER Preset and not a FACTORY Preset (which
cannot be modified). When one chooses the “Save As” function, a
window opens allowing the user to name and classify the new preset
according to TYPE and CHARACTERISTICS).
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NOTE : So that the foundations of the instrument remain intact, it is not possible to save or delete a
Factory Preset (Presets that come installed in the software). However, the Save As function allows the
modification and saving of a Preset under another name that the user chooses.

3. SAVE: permits one to save a USER Preset.
4. DELETE: you can delete any USER preset with this function.

5. IMPORT: Permits the user to import a document containing the USER
Presets for Analog Factory (allowing you to add Presets from your
personal collection). The document referred to is called “*.afpresets”. To
import, click on IMPORT and then the local “*.afpresets” document in
your computer. If the document(s) being imported have the same name
as existing Presets, the following options will appear: Duplicate, Replace
or Skip. “Duplicate” leaves two presets with the same name listed in the
Preset Manager. "“Replace” will replace the current preset with the same
name with that of the one being imported. “Skip” will stop the new
preset from being imported.

6. EXPORT: Choose this function to export USER Presets. Click on
“Export”, choose the destination of the “*.afpresets” document which will
be created, and give it a name.

NOTE: so that the foundation of Analog Factory remains intact, it is not possible to Import/Export Factory
Presets.

7. MIDI IN: light signaling MIDI activity (will illuminate when a note from
an external MIDI controller or keyboard is pushed)

8. Channel Select: this drop-down menu offers the channel choice from
which Analog Factory receives MIDI information. Default is OMNI
(responds to data on all MIDI channels).

9. TUNE: general settings for the tuning of Analog Factory. This allows the
user to finely tune the general tuning of the instrument.

10. VIEW: choose the view of the interface. The selection buttons offer the

choice to View all of Analog Factory, only the Preset manager, or only the
Keyboard.

3.3 Using Preset Manager

Presets account for the various sounds of Analog Factory: there are 2000! A preset
contains all the settings information of the different controllers necessary to
reproduce a sound. In Analog Factory, there are various ways in which the Presets
are classed and filtered in order to simplify preset management and find the
appropriate sounds for a song; one won't have to search 2000 presets to find the
desired sound. These filters are listed on the left of the Preset Manager Menu and
presented as follows: Instrument, Type, and Charactericticss. Let us take a moment
to look at each.
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HIVEMIND MINIMOOG W
HOWLINZ MINIMOODG V
ToGLow MINIMOOG V
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SHANDL MINIMOOG V
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INSTRUMENT : MINIMOOG V.
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Preset Manager

3.3.1 Instrument

“Instrument” refers to one of the 6 instruments from which Analog Factory draws its
sound. The instruments include:

e Moog Modular V
e CS-80V

e minimoog V

e Arp 2600V

e ProphetV

e Prophet VS

If, for example, one clicks on CS-80 V, the Preset Manager will provide a list of
presets uniquely from the CS-80 V. But one can also chose to browse for more than
one Instrument; that means the user can look for sounds from CS-80 V and Arp 2600
V at the same time by selecting both instruments in the “Instrument” frame. When
no Instruments are selected for preset filtering, then the Manager will either
automatically list all presets or list presets based on other filters.

All presets are listed to the immediate right of the filters under Preset Name.
3.3.2 Type

“Type” refers to instrument type being synthesized. Just as in the above example,
one may select only “Type” to have access to the list below:

e Bass

e Pad
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e Lead

e EFX (sound effect)
e FM

e Brass

e Percussive

e Sequence

e  Strings
e Guitar
¢ Organ
e Piano

As with the Instrument filter, one can choose one or more Types of presets. By
selecting only BASS, the user will be given a list that contains only bass presets, and
if one chooses BASS and STRINGS both Types will be provided.

The user may also search deeper by selecting and combining the different filters. For
example, one may choose BASS, PAD, and STRINGS under the Type filter and MOOG
MODULAR V and ARP 2600 V in the Instruments filter. The Preset Manager will then
offer a list fulfilling only the above criteria.

3.3.3 Characteristics

To further filter the choices, there is a third filter offered. “Characteristics” allows the
user to choose presets according to a mood or ambiance. The choices available are
as follows:

. Bright

. Dark

° Aggressive
o Quiet

o Hard

o Soft

° Complex

. Simple

o Short

° Long
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. Bizarre

o Acid

o Ambient

. Digital

. Ensemble

o Noise

o SoundTrack
° Funky

Once again, these filters can be applied either individually or in any combination that
the user wishes in order to find the ideal presets.

3.3.4 Entries Found

This number, found at the bottom right of the Preset Manager, indicates the amount
of Presets that correspond to a preset search.

3.3.5 Filter Options

Above the filters are three buttons: Reset, Favorites, and User. These buttons
function as follows:

RESET : removes any filters that the user may have applied to the
presets so that a new search may be started.
FAVORITES : presents only the favorites that the user has checked in the

favorites list (see 3.2.7). When the Favorites Filter Option is
selected, then the filters (Instrument, Type, and
Characteristics) will be applied only to the list of favorites.

USER : an abbreviation of USER PRESETS. Since the user can
modify and create new presets, he may also choose the Filter
Option “USER” in order to view and search among only the
presets created by the user.
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3.3.6 Current Preset Information

Information on the current preset, or an “Identity Card”, is found to the right of the
Preset Manager. An image of the original instrument which the preset is based upon

Do oOoO0OmOOocOoo OO

4

PRESET :

INSTRUMENT :

AUTHOR : CENGEL
POLYPHORMY: 16

MEMORY4

is presented along with the following information:

Preset: the name of the current preset

Instrument: the name of the virtual instrument

MINIMODG W

Author: the name of the sound designer who created the preset

Polyphony: this shows the number of available voices for the current preset.

EDIT PRESET

: if the current preset selected is a USER Preset, it is possible
By clicking on this option, a window
similar to that of the Save As function appears. It is possible
to change the Preset Name, Type (Bass, Brass, Pad, Lead,
etc ...) and the Characteristics (one must simply click in the
boxes corresponding to the 18 possible options: Bright, Dark,

to edit its information.

Aggressive, Quiet, Hard, Soft, etc...).

PRESET NAME [ My PRESET - PAD NR 20 |

el e —

CHARACTERISTICS ] Bnoght

O Dawic

[ hggressive
# Quist

O Haxd

O &aft

ﬂ Camplex
1 Semple

] Shomt

# Lorg

O Bemerre

] Add

& Ammient
O] Digaal

[ Ems=mbis
] Mois=

] Saundtrack
O Funky

EDIT Preset Window
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3.3.7 Organisation

In addition to the Preset Filters that help the user easily search and select among the
2000 various presets, there are also view options within the Preset Manager that
permit the user to choose how the presets are listed.

When the user selects the filter criteria, the list of Presets appears in a vertical column
in the middle of the screen under Preset Name. By default, the presets will be listed
automatically in alphabetical order from A to Z under Preset Name. However, if the
user prefers, the presets can be arranged on the screen according to other criteria in
the adjacent columns:

INSTRUMENT : in this column, the name of the original instrument that produced
the sound is offered for each preset. Therefore, it will list among
the following instruments: minimoog, Moog Modular V, ARP 2600 V,
CS-80 V, Prophet 5 or Prophet VS. When the user clicks on the title
bar labeled Instrument, the columns will reorganize alphabetically
under the Instrument column.

TYPE : in this column, the TYPE of instrument appears corresponding to
each preset. By clicking at the top of the column on the TYPE title
bar, the presets presented will be listed alphabetically according to
TYPE in the same column.

CPU : in this column, the CPU usage rate appears for each preset. By
clicking the title bar labeled CPU at the top of this column, the
presets will be arranged on a scale from 1 to 5. 1 represents a
weak CPU usage rate while 5 represents a strong CPU usage rate.

FAVORITES : (FAV) permits the user to classify presets according to usage or
general preference as one does in popular media players. Simply
check one’s favorite presets and access them by clicking the title
bar at the top of the column. One may also easily access the
Favorites with the Favorites Filter Option.

3.4 Keyboard View

The Keyboard view of Analog Factory (accessed either by the “Keyboard” or “All” view
in the toolbar) gives the user access to both the virtual keyboard and all the controls
with which the user can modify the sound of the presets. We will take a moment now
to look at those controls.

3.4.1 Virtual Keyboard

The knob called "LEVEL"” controls the general volume of Analog Factory. The more
the knob is turned to the right the higher the output level is raised.

The virtual keyboard visually presents 32 keys and allows one to produce the sounds
of Analog Factory without the need for an external master MIDI keyboard. With the
aid of the TRANSPOSE function found to the left of the virtual keyboard above the
modulation wheels, the user may scroll up or down the keyboard for notes in higher
or lower ranges than is visually presented.
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| CHOEUS DELM :

Virtual Keyboard

3.4.2 The Wheels

The wheels found on the left side of the virtual keyboard, give the user control over
the frequency of the sound (*PITCH"”) and the modulation rate ("MOD").

i

MOD WHEEL

P‘ITEH BEND

Wheels

PITCH WHEEL : Wheel controlling the pitch of the tone. When pushed in
the up direction, the sound “bends” and becomes higher in
tune. When pushed in the Down direction, the sound
“bends” and becomes lower in tune.

MOD : Wheel controlling modulation (MIDI controller #1)
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3.4.3 Filter

N

A
CUTORF
FILTER

Filter

CutOff : modifies the cut-off frequency (this filter has the ability to
make the sound more or less bright by controlling the
amount of high frequencies)

Resonance : (RESO) modifies the resonance of the filter (the sound
becomes more “cutting” when the parameter is pushed)

3.4.4 LFO

The LFO, Low Frequency Oscillator, is used as a modulation source for Analog
Factory’s sound. It allows the user to create variations in a sound parameter to
generate diverse effects such as a vibrato, “wahwah” effect, etc. The two parameters
that may be modulated within the LFO are:

LFO

Rate : knob setting the LFO rate/speed
Amount: knob setting for the amount of LFO modulation

3.4.5 Key Parameters

The key parameters section will prove to be particularly useful. This section is found
in the middle of the Keyboard View and labelled with the aforementioned name (Key
Parameters).

ARTURIA — ANALOG FACTORY - MANUAL 23



LR QNGO

KEY PARAMETERS

Key Parameters

Each preset offers the four most pertinent parameters unique to that preset. Our
sound designers have taken the greatest care to assign parameters that will enrich
and give depth to the sound of each preset. In this way, only the parameters that are
the most beneficial when modifying/tweaking a given sound are available, facilitating
the production process.

To know which 4 parameters have been selected for each preset, one must simply
point the mouse over a Key Parameter knob and an information block will appear
specifying the parameter name.

3.4.6 FX MIX (Effects Mix)

Analog Factory also carries a simple yet efficient effects section. The two effects,
Chorus and Delay, are automatically synchronized to the tempo of a piece in the
user’'s sequencer. If none the less, the user wishes to access more advanced effets,
they are available in most sequencer programs (Cubase, Garage Band, Pro Tools, to
name just a few).

Chorus : the Chorus effect permits one to double and detune the sound in
order to make it deeper and richer. The Chorus MIX controls the
amount of Chorus applied to the original sound, making it more wet
or dry.

Delay : the Delay carries an echo effect (repetition of the sound) that gives
space to the tone. The speed of these repetitions is automatically
synchronized to MIDI tempo (the tempo of a song in the host
sequencer). The user simply has to adjust the Delay MIX knob to
control the quantity of the effect.

3.4.7 ADSR faders

The "ADSR” envelope is composed of four successive sequential periods in the life of a
note: Attack time, Decay time, Sustain time, and the Release time.

ATTACK : begins when a note is activated. The Attack time may be short
and dry (as in percussion) or long and ascending (as with a
pad sound)

ARTURIA — ANALOG FACTORY - MANUAL 24



DECAY . follows the Attack. The Decay is a period in which the
amplitude of the sound is reduced to the sustain level.

SUSTAIN : the sustain of the note, as long as the note is active/held

RELEASE : the end of the sound. The release can be short or stretch out
over a longer duration

Thanks to these 4 faders (A, D, S, and R) one can very simply edit the amplitude
curve envelope of each sound within Analog Factory. If, for example, one finds a
sound pleasant but the attack is too long, he can use the A fader to reduce it.

« ADSR » envelope

As will be described in the following paragraphs, the diverse parameters of Analog
Factory can be controlled from an external MIDI keyboard making the manipulation of
the instrument much more practical and quicker than manipulations with a mouse. It
is in this spirit that the instrument was created. It is recommended to use Analog
Factory with an external MIDI keyboard.

3.4.8 SNAPSHOT Buttons

F

Snapshot buttons

The Snapshot buttons are found at the top left hand corner of the Keyboard view.
These eight buttons allow the user to quickly save any preset being used, along with
modifications that may have been made to them, for easy access. These 8 snapshots
are automatically saved when Analog Factory closes and will be automatically
available when the program is reopened.

This feature is especially useful when an artist plays live because these 8 Snapshots
can then be easily accessed from a MIDI interface. This means that the user can
stock 8 favorite presets along with any modifications previously made, and have
everything needed at the touch of a button on a MIDI interface during a live session
without referencing the computer screen.

It can also be useful for comparing modifications to sound in order to choose which
fits best into a musical production. For example one could store 8 different states of
the same preset: first state or original, second with the Cutoff applied, third state
using the delay, etc...

To take a Snapshot:
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Simply Shift+Click on one of the buttons in order to save the preset currently
being used.

Then, later, to recall the preset along with any modifications that may have been
made to it, click on the same button.

If the same Shift+Click operation is done on the same button, then the current
Snapshot will be replaced without prompting the user.

3.4.9 MIDI control

Most of the knobs, sliders, and switches on the Analog Factory can be manipulated
with external MIDI controllers, and this is ideally the way they should be controlled, in
order to get a high level of usability. Before anything else, the user should make sure
that the MIDI device being used is correctly connected to the computer, and that the
sequencer or the Analog Factory application is correctly configured to receive MIDI
events coming from the device.

Every instance of the Analog Factory receives MIDI events transmitted on a given
channel. This reception channel is defined in a global manner for the synthesizer,
either in the sequencer, or in the standalone Analog Factory application. On the
reception channel, the Analog Factory can receive different MIDI controls.

It is possible to choose a reception control for each knob, which means assigning an
external controller to a given parameter. For this, one should click on the knob
being used while holding down the Control key. A configuration window appears
and offers the choice of a MIDI control number. The user can also click on the
«Learn» button and move one of the physical MIDI controllers. In this case, the
control number will be detected and configured automatically. To deactivate the MIDI
control of a knob, simply uncheck the «Active» option in the MIDI control window.

il
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4 Modes of Operation

4.1 Stand-alone and Midi-Configuration

The stand-alone application allows the use of the ANALOG FACTORY outside of any
host application. You can open the instrument from its location in the start menu or
on your desktop, and play directly with the help of a master MIDI keyboard or
external sequencer on a separate computer.

4.1.1 Launching the Stand-alone application
To launch the Stand-alone application on your PC, go into the Start menu->Programs-
>Arturia-> ANALOG FACTORY and choose ANALOG FACTORY.

On a Macintosh, open the folder /Applications/ Arturia ANALOG FACTORY / and double
click on the application icon ANALOG FACTORY.

4.1.2 Preference Configuration

In order to access the preferences window, click on the menu “File -> Audio & Midi
Preferences” (Macintosh and PC). This window allows you to configure the global
preferences of the ANALOG FACTORY application. These are saved automatically.

Audio Preferences : _?.'(_i

audio device: Périphérique audio principal

sample rate: |44100 Hz

[ | [ ][9]

audio buffer size: 960 samples (21.8 ms)

output channels: | Left & Right

3

active midi inputs:

The preference window

e Audio Device: Here, select the driver corresponding to the sound menu that
you wish to use.
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e Sample Rate: Here, choose the sampling frequency among those proposed by
your sound menu. Note that a higher sampling frequency rate settings will
demand increasing processor performance from your computer.

e Audio Buffer Size: Here, you can configure the optimal audio latency as it
relates to performance of your sound card. Be careful with this setting, as a
latency setting lower than your system can support can cause unwanted
artifacts in the sound.

e Output Channels: Select the audio output channel. If the sound menu offers
several outgoing channels, choose the pair of output channels that you wish to
use.

e Active MIDI input: Select the MIDI devices you want to use to control the
synthesizer.
4.2 VST

4.2.1 Installation

Under Windows

During installation, select the box <<VST>> among the proposed format choices of
plug-ins. The installer will automatically detect the VST folder of the instruments
used by Cubase. In the case of another compatible VST sequencer, such as Logic
Audio, you will have to manually copy the plug-in file in the appropriate folder. You
will be able to find this file after the installation in the folder:

C:\Program\Files\Arturia\ANALOG FACTORY\. The file is called ANALOG FACTORY.dII

Under Mac OSX

The VST plug-in is automatically installed in the folder of the system corresponding to
the VST instruments: /Library/Audio/Plug-Ins/VST/. The VST plug-in will be usable by
all your VST host applications.

4.2.2 Instrument use in the VST mode

The opening of VST ANALOG FACTORY plug-ins is the same as opening all other VST
plug-ins. Please consult the instruction manual of your host sequencer for more
specific information. Under Cubase SX, open the menu / VST Instruments, and choose
ANALOG FACTORY in the rack
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| ® O ) VST Instruments
|

v No VST Instrument

Drums >
Synths >
ABL Pro
Analog Factory.vst
ARP2600 V.vst
Brass

C5-80V (10 voices).vst
C5-80V.vst

minimoog V.vst

Moog Modular V 2.vst
prophetv.vst

T —

Analog Factory opening in Cubase SX3

Connection to a MIDI track

So that ANALOG FACTORY can play information coming from a MIDI track, you have
to choose a MIDI track and select ANALOG FACTORY as MIDI <<output>> of this
track. See the picture below for more detail on how this is accomplished.

® U Rjwje =)o

og Factary.vst = G =

v Analog Factory.vst

Connection of a MIDI track to ANALOG FACTORY

The events played on a MIDI keyboard are recorded by your host sequencer, and now
you can use the MIDI editing possibilities of the sequencer to control any parameter
with ANALOG FACTORY.

Saving of presets

When the session/project is saved, ANALOG FACTORY is saved in its last mode of
operation, with all modifications intact. For instance, if you were working on a “P1”
preset in which you have modified parameters (without saving them as a separate
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voice in the plug-in itself), at the next opening of the piece, ANALOG FACTORY will
load the “P1” preset and the modifications.

The drop-down menu with the VST sequencer allowing you to save a new voice is of
course usable with ANALOG FACTORY. However, it is highly advised to use the
ANALOG FACTORY internal menu: the presets saved in this way are usable in any
other mode (standalone or other sequencer), they can be exported and exchanged
more easily, and they will remain compatible with the future ANALOG FACTORY
versions.

Automation

The automation works the same with ANALOG FACTORY as with any VST plug-in (for
more detail about automation, refer to the VST sequencer documentation).

4.3 _Audio Unit (Max OSX only)

4.3.1 Installation

The Audio Unit plug-in is automatically installed in the folder reserved for this
purpose, in /Library/Audio/Plug-Ins/Components/

4.3.2 Use in Logic Audio

Select an instrument track. On the slice of the mixer corresponding to the selected
track, click on the button <<I/O>> to obtain the list of plug-ins, then select
<<Stereo -> AU Instruments -> Arturia ANALOG FACTORY

No plug=in

Mana

Stereo AU Generators

Multi Channel Al Instruments
AL MIDI controlled FX Arturia Analog Factory
Logic Native Instruments ARPZE00 V

Toontrack BRASS
C5-30v
minimoog ¥V
Moog Modular V 2
Prophet V

ANALOG FACTORY opening in Logic

Since version 7, there has been an Audio Unit plug-in manager in Logic. To launch it,
click on the menu <<Preferences -> Start Logic AU Manager>>
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iFiIe Edit Audio Options Windows 1 Help

D @  About Logic Pro &u

Preferences... Global...
Learn about Jam Packs Audio...
Al Register Logic Pro MIDI...
Provide Logic Pro Feedback Display...
) Score...
Services [ 4 Video...
Hide Logic Pro 3£ H Automartion... A
Hide Others A a&H Initialize All Except Key Commands...
Show All Start Logic Setup Assistant...

Quif LOgiC Pro ggo- Start i_cgic Al Manager...
Control Surfaces [ 3

Key Commands... K

Launching of the Audio Unit manager of Logic

This Manager allows us to see the list of the available plug-ins, to test their
compatibility with Logic, and to activate or de-activate them.

If it happens that one of the Arturia plug-ins poses a problem in Logic, start by
checking that this plug-in has passed the compatibility test, and that it is actually
selected for use.

4.3.3 Use in Digital Performer

To add an instrument, choose the menu<<Project -> Add Track -> Instrument Track
-> ANALOG FACTORY”

Opening of ANALOG FACTORY in the Digital Performer

Once you have added this instrument, it's possible to assign a MIDI track to it. In the
connection menu of the MIDI track, select the instrument and the MIDI channel that
you want to use.
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|
Y Analog Factory-1- 1
Analog Factory-1-%
Analog Factory-1-3
Analog Factory-1-4
Analog Factory-1-5
Analog Factory-1 Analog Factory-1-6
Analog Factory-1-7
microkONTROL Port 1 Analog Factory-1-8
microkOMTROL Port 2 Analog Factory-1-9
Analog Factory-1-10
Analog Factory-1-11
Analog Factory-1-12
Analog Factory-1-13
Analog Factory-1-14
Analog Factory-1-15
Analog Factary-1-18

New Device Group...

Connection from a MIDI track to ANALOG FACTORY

4.4 Pro Tools

4.4.1 Installation
On Mac OSX, the plug-in is directly installed in the folder reserved for the Pro Tools
plug-ins, in /Library/Application Support/Digidesign/Plug-Ins/

On Windows, at the time of the installation procedure, select the RTAS plug-in among
the proposed choices of plug-ins. Then, when the system asks, indicate the folder in
which the other RTAS plug-ins are located.

Usually, its access path is:

C:\Program Files\Common Files\Digidesign\DAE\Plug-Ins\

4.4.2 Utilization of the plug-in

Opening of the plug-in

Access to the ANALOG FACTORY plug-in is like all other plug-ins, via an audio track
insert:
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EQ multi-channel plug-in

Z105 G*2 Dynamics multi-mono plug-in
Reverk
[1z0 [1ee J1s0 Delay

[4000000 Modulation
Dither
Instrument

minimoog V (stereo) -
Prophet V (stereo)

Opening the ANALOG FACTORY in Pro Tools

ANALOG FACTORY must be loaded on an audio stereo track. We can now make
ANALOG FACTORY sounds by playing with the mouse on the virtual keyboard.

Connection to a MIDI channel

So that ANALOG FACTORY can play the information coming from a MIDI track, you
have to associate it to a MIDI channel via the appropriate menu. (See the Pro Tools
menu for more information on plug-in connection).

L A ) parsiazesy

AnalgFotry

Analog Factory,] - channgl-1

Predefined

|
100 || 1005

Connecting a MIDI track to ANALOG FACTORY

Saving the presets

When the session is saved, the status of ANALOG FACTORY is saved as it is, even if its
programming does not correspond to the preset. For example, if you are working on
a preset <<P1>> in which you have modified the parameters (without saving them in
the plug-in itself), the next time you open the session, ANALOG FACTORY will charge
the <<P1>> preset plus the modifications.
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The <<Librarian Menu>> of Pro Tools is able to be used with ANALOG FACTORY like
with all other plug-ins. Nevertheless, it is highly recommended to use the internal
ANALOG FACTORY menu: with the presets saved like this, they are usable no matter
which mode (standalone or other sequencer), and they can be exported, exchanged
more easily, and will stay compatible with the future versions of ANALOG FACTORY.

Automation under Pro Tools

The automation function with ANALOG FACTORY like with all RTAS/HTDM plug-ins
(make reference to the Pro Tools documentation for more details on the plug-in
automations).
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ARTURIA ANALOG FACTORY - LICENSE AGREEMENT

Grant of License

In consideration of payment of the Licensee fee, which is a portion of the price you
paid, Arturia, as Licensor, grants to you, the Licensee, a nonexclusive right to use this
copy of the ANALOG FACTORY program (hereinafter the "SOFTWARE") on a single
computer at a time. All rights not expressly granted to Licensee are reserved to
Arturia.

Software Ownership

As the Licensee you own the disks on which the SOFTWARE is recorded or fixed.
Arturia shall retain full and complete title to the SOFTWARE recorded on the enclosed
disks and all subsequent copies of the SOFTWARE, regardless of the media or form on
or in which the original disks or copies may exist. This License is not a sale of the
original SOFTWARE.

Copyright Restrictions

This SOFTWARE and the accompanying printed or written materials are copyrighted.
Unauthorized copying of the SOFTWARE, including those instances where the
SOFTWARE has been modified, merged, or included with other Software, or of the
printed or written materials, for any reason, is expressly forbidden. Licensee may be
held liable for copyright infringement which results from such unauthorized copying.

Restrictions on Use

Licensee may physically transfer the SOFTWARE from one computer to another,
provided that the SOFTWARE is used on only one computer at any one time. Licensee
may not electronically transfer the SOFTWARE to multiple computers over a network
system. Licensee may not distribute copies of the SOFTWARE or accompanying
materials to others. Licensee may not modify, adapt, translate, reverse engineer,
decompile, disassemble, or create derivative works based on the SOFTWARE or its
accompanying printed or written materials.

Transfer Restrictions

Licensee shall not assign, rent, lease, sell, sublicense or otherwise transfer the
SOFTWARE to another party without prior written consent of Arturia. Any party
authorized by Arturia to receive the SOFTWARE must agree to be bound by the terms
and conditions of this Agreement.
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LIMITED WARRANTY AND DISCLAIMER

Limited Warranty

Arturia warrants that the disks on which the SOFTWARE is furnished to be free from
defects in materials and workmanship under normal use for a period of thirty (30)
days from the date of purchase. Your receipt shall be evidence of the date of
purchase. Any implied warranties on the SOFTWARE are limited to thirty (30) days
from the date of purchase. Some states do not allow limitations on duration of an
implied warranty, so the above limitation may not apply to you. All programs and
accompanying materials are provided “as is” without warranty of any kind. The
complete risk as to the quality and performance of the programs is with you. Should
the program prove defective, you assume the entire cost of all necessary servicing,
repair or correction.

Remedies

Arturia's entire liability and your exclusive remedy shall be at Arturia's option either
(a) return of the purchase price or (b) replacement of the disk that does not meet the
Limited Warranty and which is returned to Arturia with a copy of your receipt. This
limited Warranty is void if failure of the SOFTWARE has resulted from accident, abuse,
modification, or misapplication. Any replacement software will be warranted for the
remainder of the original warranty period or thirty (30) days, whichever is longer.

No other Warranties

The above warranties are in lieu of all other warranties, expressed or implied,
including but not limited to, the implied warranties of merchantability and fithess for a
particular purpose. No oral or written information or advice given by Arturia, its
dealers, distributors, agents or employees shall create a warranty or in any way
increase the scope of this limited warranty.

No Liability for Consequential Damages

Neither Arturia nor anyone else involved in the creation, production, or delivery of this
product shall be liable for any direct, indirect, consequential, or incidental damages
arising out of the use of, or inability to use this product (including without limitation,
damages for loss of business profits, business interruption, loss of business
information and the like) even if Arturia was previously advised of the possibility of
such damages. Some states do not allow limitations on the length of an implied
warranty or the exclusion or limitation of incidental or consequential damages, so the
above limitation or exclusions may not apply to you. This warranty gives you specific
legal rights, and you may also have other rights which vary from state to state.
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